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Alma February 2016 Release Highlights 

Resource Management  

 Efficient Creation of Multiple Portfolios for a Bibliographic Record – To ensure more 

efficient inventory creation, time-saving features have been incorporated into Alma for 

adding multiple portfolios. For example: efficient creation of multivolume e-books (with 

different portfolios for the same bibliographic record). 

 Community Zone Electronic Collections Enhanced with Collection Level Bibliographic 

Record Content – All the electronic collections in the Alma Community Zone are being 

updated with electronic collection-level bibliographic records. After an electronic collection 

has been activated, you can use the All titles search to retrieve electronic collection 

bibliographic record results. The collection level bibliographic record can also be exposed in 

the discovery system. Note that this enhancement is being implemented in phases starting 

with the February 2016 release of Alma.  

 Derive an Authority Record from a Headings in the Bibliographic Record – Additional 

productivity enhancements are being provided in the MD Editor related to creating local 

authority records when there is no headings match. There are cases in which a cataloger 

catalogs a bibliographic record with a headings field that cannot be linked to an existing 

authority record. For these cases, Alma now provides a quick creation option for creating a 

local authority record with the relevant content. This capability is provided for institutions 

that have the appropriate parameters set for managing local authority records. 

 MD Editor Usability Enhancements – In a continuing effort to provide productivity 

improvements in Alma, the February release incorporates several enhancements to the MD 

Editor that include input from the Idea Exchange related to viewing inventory. 

 Sharing Import Profiles Between Institutions – Institutions spend a great deal of time 

creating import profiles to import records from external systems. Many institutions 

integrate with the same external systems. In order for these institutions to save time and 

effort, librarians can now use the import profiles that other institutions contribute to the 

Community Zone. 
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Fulfillment 

 Aggregate Lost/Overdue Notifications (a NERS enhancement) – Alma can now be 

configured to send a single overdue or lost item notification to the patron listing all of the 

patron's overdue or lost loans. This can be used to replace the previous option where a 

notice was sent for each overdue or lost loan.  

 User Anonymization for Fines/Fees – A configuration parameter can be used to activate 

fines/fees anonymization. Anonymizing fines/fees will detach any closed (that is, fully paid 

or waived) fine/fee from the user record of the patron who owed it. Statistical patron 

information, such as User Group and User Statistics, will remain on the fine/fee record and 

be fully reportable in Analytics.  

 Enhanced Digitization Workflow – The staff workflow for processing digitization requests 

has been enhanced so that digitized files may be added to titles with the Alma Add 

Representation functionality, simplifying the digitization process. This development 

replaces the deposit workflow currently in use. 

Collaborative Networks 

 Local Authority Enhancements in the Network Zone – Collaborative network members 

can now share cataloging activity in relation to authority records that are managed centrally 

in the Network Zone by creating and editing authority records that are managed centrally in 

the Network Zone.  

Analytics 

 Permanent Call Number and Fulfillment Note Fields Added to Physical Items Details 

Dimension – The Permanent Call Number and Fulfillment Note fields have been added to 

the shared Physical Item Details dimension of the Fulfillment subject area. The Fulfillment 

Note field has also been added to the Physical Item Details dimension of the Requests 

subject area. In addition, the Physical Item Details dimension has been added to the Lending 

Requests subject area.  
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 Lifecycle Field Added to Portfolio Dimension – The Lifecycle field has been added to the 

Portfolio dimension of the E-Inventory subject area. This allows you to filter reports by 

Active/Deleted items. 

Alma Usability 

 New Option to Export All Fields of a Modified Table to Excel – When exporting a table 

with hidden columns to Excel, you can now choose to export only the visible columns or all 

of the columns, including the hidden ones. 

 Inventory Number and Inventory Price Columns Available for List of Items – The 

Inventory Number and Inventory Price fields can now be displayed on the List of Items 

page. 

 Keyboard Shortcuts Added to Alma UI – A number of keyboard shortcuts have been 

added to the Alma UI. A tooltip with the shortcut appears when hovering over the button.  
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Alma Show Me How and Videos 

The following sections describe Alma Show Me How and videos for this release of Alma. 

Alma Show Me How 

Description 

Alma Show Me How provides a menu-driven interface to prompt you through the steps of new 

or common tasks, or to point out new options, such as a check box, and direct you to the 

documentation that describes the new options in further detail. 

Step-by-Step Instructions 

Each Show Me How scenario may address different areas of Alma. The authorizations required 

to access the Show Me How scenarios are specific to the functional areas of the scenario. 

To access Show Me How: 

1 From the Alma home page, click Show Me How. 

The How Can We Assist You? pop-up window displays. 

2 Select one of the processes in order to start the prompted step-by-step instructions. 

Alma Videos 

The following new videos are available from the Show Me How menu, and when you select 

Help > What's New Videos in Alma: 

 Efficient Creation of Multiple Portfolios for a Bibliographic Record 

 Derive an Authority Record from a Headings in the Bibliographic Record  

 Sharing Import Profiles Between Institutions 

 Local Authority Enhancements in the Network Zone 

https://youtu.be/ErDDfXdEK04
https://youtu.be/LH6n4S_dh9I
https://youtu.be/0_pwZQCxUkk
https://youtu.be/fJCqu8G784Y
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Making the Most of This Release 

The following release note features require actions or decisions on the part of your institution in 

order to implement: 

Action Items 

☐ Sharing Import Profiles Between Institutions – Looking to import records from an 

external provider?  Check the Community Zone to see whether it includes a specification 

of the import profile for your use. Do you have an import profile that you would like to 

share with the community? You can now upload it to the Community Zone for others to 

use.    

☐ Aggregate Lost/Overdue Notifications_Sharing_Import_Profiles - As most libraries do, 

your library probably sends out patron notices for long overdue items. With this release, 

you can upgrade your patrons’ experience to receive a single notice for multiple overdue 

loans instead of multiple notices (the only option until now). Activating this option is just 

a simple flag configuration away from you now! 

☐ Enhanced Digitization Workflow_Sharing_Import_Profiles - Do you digitize physical 

library material? Would you like to store the digitized content as part of your temporary 

or permanent digital inventory? The wizard for doing this is so much simpler now. With 

minimal clicks and using an intuitive interface, you can add the new digital 

representation and files into Alma’s digital inventory as part of your digitization 

workflow. 
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Acquisitions 

The following enhancements were made in the Acquisitions functional area for this release of 

Alma: 

 When creating an invoice, the Vendor and Vendor Account fields now appear above the 

Total amount and Total invoice lines amount fields. After selecting a vendor, the currency 

unit defaults to one associated with the vendor. 

 

Figure 1 - Create Invoice Page 2 

 User information icons were added to the Participants tab of the Trial Details page. 
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Figure 2 - Trial Details Page, Participants Tab 

 **Idea Exchange feature – Allocated Balance was added to the Funds and Ledgers. This is 

the sum of all allocated transactions of the fund/ledger. This field also appears in Excel file 

when the page is exported.  
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Figure 3 - Funds and Ledgers Page 

 When the new Acquisition configuration parameter no_e-task_on_close_po_line is set to 

true, a task is not created when an electronic PO line is closed (the task reminded the user to 

deactivate the resource). Typically this is relevant for a continuous order. The default for 

this parameter is false, which corresponds to the existing functionality. 
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Resource Management 

The following sections describe new or changed Resource Management features in this release 

of Alma. 

Efficient Creation of Multiple Portfolios for the Same 

Bibliographic Record 

Description 

To ensure more efficient inventory creation, time-saving features have been incorporated into 

Alma for adding multiple portfolios such as the creation of multivolume e-books that have 

different portfolios for the same bibliographic record. These enhancements are available in the 

following functional areas: 

 Adding new local portfolios with Resource Management > Create Inventory > Add Local 

Portfolio 

 Adding new local portfolios for a bibliographic record in the MD Editor 

 Adding new local portfolios through the Electronic Service Editor 

Step-by-Step Instructions 

The following role can add multiple local portfolios using the new time-saving features: 

 Electronic Inventory Operator 

To access the new time-saving options when using Add Local Portfolio and adding 

multiple portfolios: 

1 Open the New Portfolio page (Resource Management > Create Inventory > Add Local 

Portfolio) and enter the portfolio information as you normally do. 

2 Open the list of Save options. 
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Figure 4 - New Save Options on the New Portfolio Page 

The new Save options include the following selections: 

 Save and Done – This option provides the same functionality previously known as 

Save. It saves the portfolio information that you entered and closes the New Portfolio 

page. 

 Save and Create Duplicate – This option saves the portfolio information that you 

entered and automatically repopulates the New Portfolio page with the same 

information for you to edit for the next portfolio to be created. 

 Save and Create New – This option saves the portfolio information that you entered 

and reopens the New Portfolio page for you to enter the next new local portfolio to be 

created, thereby saving the steps of opening the New Portfolio page again manually. 

3 After selecting one of the Save options, click Go, and continue entering additional 

portfolios. 

To access the new time-saving options when using the MD Editor and adding multiple 

portfolios: 

1 Complete a Repository Search for a bibliographic record to which you want to add 

portfolios. 

2 From the Repository Search results page, click Edit for a bibliographic record to which you 

want to add portfolios. The MD Editor page opens with the details of the bibliographic 

record. 
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3 Click the Add Local Portfolio (Alt+O) icon or select Tools > MARC Bibliographic > Add 

Local Portfolio. As previously implemented, the New Portfolio page appears with the Use 

existing title radio button selected and the Choose title field filled in and identified as a 

required field with a red asterisk. The new Save options are also available from this page. 

 

Figure 5 - Adding a New Portfolio to a Bibliographic Record from the MD Editor 
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4 Enter the information for the first portfolio and select one of the Save options (as described 

above) and click Go. 

When you select Save and Create Duplicate to add multiple portfolios, the New Portfolio 

page appears automatically. The Choose title field continues to be filled in with the title 

information from the bibliographic record plus the other information that you 

entered/saved repopulates the New Portfolio page. 

When you select Save and Create New to add multiple portfolios, the New Portfolio page 

appears automatically. The Choose title field continues to be filled in with the title 

information from the bibliographic record, and the manually entered information is cleared 

to allow new portfolio creation. 

To access the new time-saving options when using the Electronic Service Editor and 

adding multiple portfolios: 

1 Complete a Repository Search for an electronic collection to which you want to add 

portfolios. 

2 From the Repository Search results page, click Edit Service for electronic collection to which 

you want to add portfolios. The Electronic Service Editor page opens with the details of the 

service information for the electronic collection. 

3 Select the Portfolios tab. 

4 Choose one of the following options: 

a Actions > Duplicate. 

For a local portfolio, select Actions > Duplicate. This is a new Actions option that 

duplicates the local portfolio information (internal description, PO line, override 

information such as coverage, authentication note, and public note) from the local 

portfolio from which you selected this action and opens the Electronic Portfolio Editor 

page with the duplicated information for you to edit. 
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Figure 6 - Duplicating a Local Portfolio from the Service Editor 

b Add Local Portfolio. 

Click Add Local Portfolio. As previously implemented, the New Portfolio page appears 

with the Use existing title radio button selected and the Electronic Collection field and 

the Service field filled in and identified as required fields with a red asterisk. The new 

Save options are also available from this page. 
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Figure 7 - Adding a Local Portfolio from the Service Editor 

Enter the information for the first portfolio and select one of the Save options (as 

described above) and click Go. 
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When you select Save and Create Duplicate to add multiple portfolios, the New 

Portfolio page appears automatically. The Electronic collection field and the Service 

field continue to be populated with the electronic collection and service information 

from the Electronic Service Editor plus the other information that you entered/saved 

repopulates the New Portfolio page. 

When you select Save and Create New to add multiple portfolios, the New Portfolio 

page appears automatically. The Electronic collection field and the Service field 

continue to be populated with the electronic collection and service information from the 

Electronic Service Editor, and the manually entered information is cleared to allow new 

portfolio creation. 

Community Zone Electronic Collections Enhanced 

with Collection-Level Bibliographic Record Content  

Description 

All the electronic collections in the Alma Community Zone are being updated to have electronic 

collection-level bibliographic records. Based on the data available for each electronic collection 

in the Central KnowledgeBase, valid MARC records are being created. After an electronic 

collection has been activated, you can use the All titles search to retrieve electronic collection 

bibliographic record results. Having collection-level bibliographic records enables the exposure 

of the collection-level information in your discovery system if you want it. 

For consortia working with a Network Zone, the Alma bibliographic synchronization process 

that activates bibliographic records in the Network Zone also updates the Network Zone with 

bibliographic records for activated electronic collections. As a result, when searching for these 

bibliographic records in the Network tab, the Held by function displays information about 

members that hold the associated electronic collections. 

Note: This enhancement is being implemented in phases starting with the February 2016 release of 

Alma. Initially, electronic collections that are added to the Central KnowledgeBase in February 

will have bibliographic records. Once these electronic collections are activated, you will be able to 

complete an All titles search for these bibliographic records. During the March 2016 release, a 

bibliographic record will be created for every electronic collection in the Community Zone. These 

bibliographic records will be harvested automatically and will be associated with the electronic 
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collections activated from the Community Zone unless you have attached the electronic 

collections to other bibliographic records. The harvested bibliographic records will be suppressed 

and will not be published unless you un-suppress them and the electronic collection has a URL. 

Step-by-Step Instructions 

The following role can work with electronic collection bibliographic records: 

 Electronic Inventory Operator 

To view electronic collection activation changes with the addition of bibliographic 

records: 

1 Complete an Electronic Collection repository search (from the Community tab) to locate an 

electronic collection that you want to activate. 

 

Figure 8 - Search for Electronic Collection to Activate 

2 Click Activate. The Activation Wizard page appears.  

The Additional descriptive information field displays content indicating that a 

bibliographic record is available for the electronic collection that you are activating. 

A new Mark bib as suppressed check box is provided. Use this check box to indicate if you 

want the bibliographic record to be suppressed. The default for this option is to suppress 

the bibliographic record. Remove this check box selection if you want the bibliographic 

record to be viewable/published to the discovery system. Unsuppressed bibliographic 

records are published to the discovery system if there is available URL information, and any 



 
 
 
 
 

 
 Ex Libris Confidential 21 

 
 
 
 
 

available URL information for the electronic collection will be discoverable. If there is no 

URL, the bibliographic record will not be published. 

 

Figure 9 - New Activation Options for Electronic Collections 

Note: Any relevant changes to the electronic collection in the Community Zone will be reflected in 

the bibliographic record and harvested/distributed. 

3 Complete the activation process as you normally would. 

To view a MARC record provided with an electronic collection: 

1 Complete an All titles search for an electronic collection from the Institution tab. 

2 From the search results, click the electronic collection title link to display the MARC Record 

Simple View page. 
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Figure 10 - Electronic Collection Bibliographic Record 

To view Network tab changes with the addition of bibliographic records in the Network 

Zone: 

1 Complete an All titles search for an electronic collection from the Network tab. 

2 Click a Held by link for the electronic collection. 

 

Figure 11 - Collection-Level Bibliographic Record Content Held By in the Network Zone 
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3 Select the Electronic Collections tab to view information provided by the bibliographic 

record associated with the electronic collection. 

 

Figure 12 – Collection-Level Bibliographic Record Content in the Network Zone Electronic Collections Tab 

To view the Electronic Collection Bibliographic Record Update filter provided in the 

Community Zone Updates Task List for electronic collection bibliographic records: 

1 Open the Community Zone Updates Task List (Resource Management > Manage 

Inventory > Community Zone Updates Task List). 

2 Open the Action drop-down list. 

 

Figure 13 - Action Drop-Down List in the Community Zone Updates Task List 
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3 Select Electronic Collection Bibliographic Record Update. The filtered list appears.  

 

Figure 14 - Electronic Collection Bibliographic Record Update Filter 

Derive an Authority Record from a Headings in the 

Bibliographic Record 

Description 

Additional productivity enhancements are being provided in the MD Editor related to creating 

local authority records when there is no headings match. There are cases in which a cataloger 

catalogs a bibliographic record with a headings field that cannot be linked to an existing 

authority record. For these cases, Alma now provides a quick creation option for creating a local 

authority record with the relevant content. This capability is provided for institutions that have 

the appropriate parameters set for managing local authority records. 
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Step-by-Step Instructions 

The following roles can access the new MD Editor option for quickly adding authority records 

for headings with no match: 

 Cataloger 

 Catalog Manager 

 Catalog Administrator 

To use the new option to add authority records for headings with no match: 

1 Open the MD Editor (Resource Management > Cataloging > Open Metadata Editor). 

2 Create a new bibliographic record (File > New > MARC21 Bibliographic). 

3 Enter headings information in an appropriate field that you know does not exist in an 

authority record and press F3. The field appears in the normal manner with the addition of 

the new Create Authority Record button. 
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Figure 15 - Create Authority Record Button 

4 Click Create Authority Record. The new authority record is created and displays in the MD 

Editor in the side-by-side, split screen format. 
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Figure 16 - Quick Authority Record Created 

The list of authority records also shows the new authority record that you created. 

 

Figure 17 - List of Authority Records in the MD Editor 

Note: When you create authority records using Create Authority Record and the focus field when 

you press F3 is a non-preferred field such as the 600 field, the content is placed in the preferred 

field 100 in the new authority record that is created. 

5 Complete processing the bibliographic record as you normally would. 
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MD Editor Usability Enhancements 

Description 

In a continuing effort to provide productivity improvements in Alma, the February release 

incorporates several enhancements to the MD Editor that include input from the Idea Exchange 

related to viewing inventory. Refer to the table below for the usability improvements made to 

the MD Editor. 

Previous Implementation Improvement 

When editing an existing indicator and using 

backspace or delete (to clear the value), the cursor 

jumps to the end of the last subfield value. 

The cursor now remains in the indicator position 

when you edit that component. 

When the text is long for a particular field, the 

MARC tag and indicators are located in the 

middle vertically. 

The preferred location of having the MARC tag 

and indicators located vertically at the top and 

aligned horizontally with the first line of the field 

has been implemented. 

When the cursor is located in a control field (001-

008) and a new data field is added, the new data 

field is placed at the end of all the data fields. 

 

When the cursor is located in a control field (001-

008) and a new data field is added, the new data 

field is placed after the 008 control field. When the 

record is saved, the data field is placed in the 

proper sequential position. 

When navigating through fields by tabbing from 

the first indicator to the second indicator, and 

then to the subfields, the curser jumps to the end 

of the field, that is, after the last subfield. 

The cursor now moves from the second indicator 

to the first subfield and then to each following 

subfield and, subsequently, to the field number in 

the next row when using the tab key. The 

shift+tab key can be used to go in reverse order 

from subfield to subfield and so forth. 

Tooltips are provided for all components of a 

field, the tag, indicators, and subfields. When the 

subfield text is lengthy, the tooltip content that 

displays hides other fields/values. 

When pointing the mouse at field content, tooltips 

are provided for only tags and each indicator 

position, not the subfields. 
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Previous Implementation Improvement 

When a bibliographic record is opened, inventory 

viewed, clicking Edit (holdings) displays the 

holdings record on the full screen. The left side of 

the screen (tree view) under the Records tab is not 

updated. Nothing is seen under holdings 

(MARC21 Holdings folder). Only after saving the 

holdings record, you can see it. 

The holdings record information is now updated 

in the MARC21 Holdings folder (under the 

Records tab at the left) when Edit is clicked. 

When a bibliographic record is opened, and 

inventory viewed, clicking Edit (holdings) 

displays the holdings on the full screen instead of 

retaining the split screen. 

The split screen is now maintained when editing 

holdings. 

For control vocabulary, closed list, one can key in 

only one letter. When there are many values, one 

can scroll down only one by one. When one keys 

in a second letter, the list jumps to that (first) 

letter in the list. 

The capability to use Page Up and Page Down 

was added in order to scroll through the list of 

options as provided with 245 $h. 

(There is a known issue with this implementation 

in the Chrome browser.) 

When clicking F3 (authority lookup), the Cancel 

button is hidden by the cataloger level. 

The Cancel button was moved so that it is visible 

when the cataloger level is displayed. 

Under the Template tab in the MD Editor, when 

you choose New from the drop-down list for a 

specific template, the record opens on the main 

screen, but on the left, you are still in the template 

list.  

When a new record is opened using the New 

option under the Template tab, the Records tab 

becomes the open and active tab with the new 

record displayed there. 

** IDEA EXCHANGE ** 

From the MD Editor holdings record, one is 

unable to view inventory. 

When working with a holdings record, the View 

Inventory option was added to the Tools > 

MARC21 Holdings list of options, and the View 

Inventory icon is an active option. 
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Previous Implementation Improvement 

In the MD Editor, when working with a holdings 

record and choosing to add an item, after saving 

the item, you are taken back to the holdings 

record. There is no view of the item that was 

added. In order to access the item that was added, 

you need to go back to the holdings record in the 

MD Editor and view the inventory on the right-

hand side. 

After adding and saving an item for a holdings 

record, the holdings and inventory/item 

information displays side-by-side, in split-screen 

mode. 

Sharing Import Profiles Between Institutions  

Description 

Institutions spend many hours creating import profiles to import records from external systems. 

Many institutions integrate with the same external systems. In order for these institutions to 

save time and effort, librarians can now use import profiles that other institutions contribute to 

the Community Zone. 

This feature includes the following procedures: 

 Contribute an import profile to the Community Zone 

 View the list of contributed import profiles 

 Copy a contributed import profile to your institution 

 Remove a contributed import profile 

Contributed import profiles appear in the Community tab on the Import Profiles page 

(Resource Management > Resource Configuration > Configuration Menu > Record Import > 

Import Profiles). New columns Contributed By and Contribution Date appear in this tab. 

These columns display the source that contributed the import profile and the contribution date 

and time, respectively. 
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Figure 18 - Import Profiles, Community Tab 

A new column Contributed By appears in the Institution tab on the Import Profiles page. This 

column displays the source that contributed an import profile. The column displays contents 

only for copied profiles. 
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Figure 19 - Import Profiles, Institution Tab 

In addition, when viewing the profile, the Sharing Details area in the Profile Details tab 

includes information about who contributed the profile. 
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Figure 20 - Import Profile Details Page 

Copying an import profile also copies the profile’s associated normalization process, associated 

merge rule, scheduling option, and the indication rule and normalization rules associated with 

its normalization process. The normalization rules appear in the MD Editor with a note about 

their original contributor. 

Step-by-Step Instructions 

The following roles can contribute import profiles or manage contributed import profiles: 

 Catalog Administrator 

 General System Administrator 

 Purchasing Manager 

 Purchasing Operator 

 Repository Administrator 

To contribute an import profile to the Community Zone: 

1 Select Actions > Contribute for an import profile on the Institution tab of the Import 

Profiles page. 
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Figure 21 - Import Profiles Page 

A confirmation message dialog box appears. 

 

Figure 22 - Import Profile Contribution Confirmation Message 

2 You can optionally change the Profile name. 

3 It is recommended that you change the Description to include detailed informations for 

institutions that will copy the profile. Include institution information such as the library 

information, FTP information, and/or vendor information. 
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4 You can optionally enter or change an email address for the Contact person. 

5 Click Confirm. The profile appears in the Community tab and can be copied by any 

institution. 

 

Figure 23 - Import Profiles, Community Tab 

To view contributed import profiles: 

You can view contributed import profiles in the Community tab of the Import Profiles page. 

To view more information about a contributed import profile, select Actions > View for one of 

the profiles. The profile details appear. 

To copy a contributed import profile to your institution: 

1 Select Actions > Copy for an import profile in the Community tab of the Import Profiles 

page. 
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The import profile is copied to your institution and the new profile is opened for editing. 

The new profile appears in the Institution tab on the Import Profiles page. Its status is 

Inactive by default. The import profile’s merge rule, normalization process, indication rule, 

and normalization rules are also copied to your institution. 

2 Make any required changes and click Save to save the profile. 

The new profile can be used like any other profile. 

To delete contributed import profiles: 

Select Actions > Delete beside the contributed import profile on the Community tab of the 

Import Profiles page, and click Confirm in the confirmation dialog box. The profile is removed 

from the list of contributed profiles. 

You can delete only profiles that your institution previously contributed. Deleting a contributed 

profile has no effect on copies that were made of that profile. 

Other Resource Management Enhancements 

 When browsing call numbers (either by selecting Browse Call Numbers in the MD Editor or 

by selecting Resource Management > Cataloging > Browse Shelf Listing), the Call number 

type drop-down list now contains options for each $2 subfield of field 084 (and one for Not 

Specified), instead of one option for all of these subfields. 

 

Figure 24 - Call Number Type Drop-down 

 In the advanced search, the condition Product Code was renamed Universal Product Code. 
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 You are now asked for confirmation when deleting a sequence on the Inventory Number 

Configuration page (Resource Management > Resource Configuration > Configuration 

Menu > General > Inventory Numbers). Also on this page:  

 Fields are checked for valid values. 

 Sequence Name, Padding, and Prefix are now limited to 255 characters. 

 Sequence Start is now limited to 18 characters. 

 You can now use the control form editor (Crtl-F) when editing a UNIMARC authority 

record (like you can when editing a UNIMARC bibliographic record). 
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Fulfillment 

The following sections describe new or changed Fulfillment features in this release of Alma. 

Aggregate Lost/Overdue Notifications   

Description 

Alma can be configured to send a single overdue or lost item notification to the patron listing all 

of the patron's overdue or lost loans. This can be used to replace the previous option where a 

notice was sent for each overdue or lost loan. Using this new option, the patron will receive a 

single notification for each notification type. 

Activating the new option is done by setting the Fulfillment Other Settings configuration 

parameter switch_to_overdue_and_lost_loan_new_job to True. The name of existing Loans – 

Change to Lost job is changed Loans – Overdue and Lost Item.   

Note: The previous option will be deprecated later this year with several months’ notification in 

order to take any required actions. 

Step-By-Step Instructions 

The following roles can configure overdue and lost loan notifications and profiles: 

 General System Administrator 

 Fulfillment Administrator 

To configure overdue and lost loan notifications: 

1 Access Fulfillment > Fulfillment Configuration > Configuration Menu > General > Other 

Settings and locate the parameter switch_to_overdue_and_lost_loan_new_job. This value 

determines whether to aggregate the notifications or leave them as they are. 
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Figure 25 - Customer Mapping Table 

2 Click Customize and enter True in the parameter value field. 
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3 Click Save. 

To configure overdue and lost loan letters: 

Note: Configuration of the new letters is not mandatory, but it is recommended. 

Access the Customize Letters page (Administration > General Configuration > Configuration 

Menu > General Configuration > Customize Letters). 
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Figure 26 - Customize Letters 

The old letters, FulLostLoanNotificationLetter and FulLostLoanLetter, are listed in addition to 

the new letters, FulOverdueAndLostLoanNotificationLetter and 

FulOverdueAndLostLoanLetter.   
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Note: The old letters, FulLostLoanNotificationLetter and FulLostLoanLetter, will be deprecated 

later this year with several months’ notification in order to take any required actions. 

User Anonymization for Fines/Fees  

Description 

A configuration parameter can be used to activate fines/fees anonymization. Anonymizing 

fines/fees will detach any closed (that is, fully paid or waived) fine/fee from the user record of 

the patron who owed it. Statistical patron information, such as User Group and User Statistics, 

will remain on the fine/fee record and be fully reportable in Analytics.  Detaching a user from 

the fines/fees is an irreversible action. 

When the option is selected, the patron information is detached from closed fines and fees by 

the Fulfillment – Handle Historical Archiving job.  The job’s report will also contain 

information on the fines and fees that were anonymized. 

Step-By-Step Instructions 

The following roles can configure fees anonymization: 

 General System Administrator 

 Fulfillment Administrator 

To configure fees anonymization: 

1 Access Fulfillment > Fulfillment Configuration > Configuration Menu > General > 

Fulfillment Jobs Configuration. 



 
 
 
 
 

 
 Ex Libris Confidential 43 

 
 
 
 
 

 

Figure 27 - Fulfillment Jobs Configuration Page 

Anonymize fines and fees is cleared by default. 

2 Select the check box to anonymize historical fines and fees.  

3 Click Save. 

Enhanced Digitization Workflow 

Description 

The staff workflow for processing digitization requests has been enhanced so that digitized files 

may be added to titles with the Alma Add Representation functionality, simplifying the 

digitization process. This development replaces the deposit workflow currently in use. 
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Step-By-Step Instructions 

To configure digitization departments, you must have one of the following roles: 

 General System Administrator 

 Fulfillment Administrator 

To manage the digitization of an item, you must have the following role: 

 Work Order Operator (in the scope of a Digitization Department) 

This development affects the digitization profile rules configured by an administrator and the 

digitization workflow performed by a digital librarian.  

To configure the digitization profile rules: 

1 Open the Digitization Workflow Setup page (Fulfillment > Fulfillment Configuration > 

Configuration Menu > Digital Fulfillment > Digitization Profile Rules> Add Rule). The 

Add digital inventory (representation) option is now available under the Workflow setup 

section. 

 

Figure 28 – Workflow Setup 

2 Select Add digital inventory (representation). The following fields appear: 

 Default Collection Assignment – Select the default collection to which to assign the 

title (if not already assigned). 

 Usage Type – Select whether the representation is the Master copy or a Derivative. (The 

master is the original copy and the derivative is, for example, a copy with a lower 

resolution.) 

 Access Rights Policy – Select the policy that defines the permissions that patrons have 

to request digital resources. 
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Note: The usage type and access rights policy can be changed when adding the digital file to the 

record, but the collection cannot. 

To add a digitized item to a record: 

1 When currently at a Digitization Department, open the In Process Items page (Fulfillment > 

Resource Requests > Manage In Process Items). 

 

Figure 29 – In Process Items 

The new status Digital Inventory appears instead of Deposit. 

2 For an item with Digital Inventory status, select Actions > Add digital inventory. The 

following page appears: 
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Figure 30 – Representation Details 

3 Fill in the fields as described in the Adding a Representation section of the Alma Online 

Help. 

4 Click Add files and select the digital version of the title. 

The digital file is added to the bibliographic record of the item. 

Other Fulfillment Enhancements 

 When calculating the expiration date of a request for pickup, the transit time rules are now 

ignored and only the Date Needed By attribute is considered. 
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 In Manage Items Returns, when returning an item that has a note, there is now a View 

Notes action in the Action menu. 

 

Figure 31 - Manage Item Returns Page 

 The profile name was added to the XML that is created by the Fines/Fees Notification job, 

allowing greater customizability of the notification for a configured profile name. In 

addition, twenty rows were added to the letter's code table, allowing different notifications 

to be created for different profiles. 

 Two columns were added to the print slip report on the pick from shelf task list: Requester 

User Group and Process Date. Process Date is the date on which the request status changed 

to Pick from Shelf. 

 Patrons whose preferred language is Hebrew are now able to receive patron notifications in 

Hebrew. 
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Resource Sharing 

The following sections describe new or changed Resource Sharing features in this release of 

Alma. 

Mapping Alma Library Codes to External Library 

Codes for Libris ILL  

Description 

A new mapping table was created to map Alma library codes to library codes in external 

resource sharing systems. This mapping table can be used in conjunction with the resource 

sharing integration profile. This will enable customers using Libris ILL to map their pickup 

library codes to Alma codes so that resource sharing requests can be imported into Alma from 

Libris.  

Step-By-Step Instructions 

The following roles can configure library mapping: 

 General System Administrator 

 Fulfillment Administrator 

To configure library mapping: 

1 Access the Library Mapping page (Fulfillment > Fulfillment Configuration > 

Configuration Menu > Resource Sharing > Library Mapping). 
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Figure 32 - Library Mapping Page 

2 Enter the external library code and the Alma library code and click Add Row.  When 

finished, click Customize. 

Controlling the Borrower Ability to Use the Reject 

Option 

Description 

The library now has an option to turn off the Reject action for borrowing requests. This is 

particularly useful for ISO requests, where the rejection is expected to be received as a message 

sent by the lender.  
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The reject option is turned on by default for most customers. It is turned off by default for the 

Alliance Network libraries. In any case, if there is no partner on the request, the reject option is 

disabled. If the partner does not have a borrowing workflow assigned, the reject option is 

enabled. 

Step-By-Step Instructions 

The following roles can configure the visibility of the reject action: 

 General System Administrator 

 Fulfillment Administrator 

To configure the visibility of the reject action: 

1 Access Fulfillment > Fulfillment Configuration > Configuration Menu > Resource 

Sharing > Workflow Profiles.  
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Figure 33 - Workflow Profiles 

2 Remove the Reject option by clicking Actions > Edit and deselect the Reject option 

(Ctrl+Click). 
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Figure 34 - Edit Workflow Profile 

The Reject action is disabled on the borrowing request. 

 

Other Resource Sharing Enhancements 

 Shipping information and bibliographic level were added to the ItemShipped NCIP 

request. 
 When you set the new Fulfillment configuration parameter 

rs_auto_request_lending_with_volume_issue to false, a move request is not automatically 

created for a lending request for an item that has a volume or issue because the move 

request may not identify the correct volume/issue. The default for this parameter is true, 



 
 
 
 
 

 
 Ex Libris Confidential 53 

 
 
 
 
 

which corresponds to the existing functionality. This parameter has no effect on items 

without a volume or issue. 
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Collaborative Networks  

The following collaborative network enhancements were made for this release of Alma: 

Local Authority Enhancements in the Network Zone  

Description 

Collaborative network members can now share the cataloging activity in relation to authority 

records that are managed centrally in the Network Zone by creating and editing authority 

records that are managed centrally in the Network Zone. When the parameters are set for 

members and the Network to manage local authorities, the following new capabilities are 

enabled: 

 Searching for the authority Network Zone record from within the Institution Zone option 

 Creating local authorities in the MD Editor using the new Create Authority Record button 

when there is no headings match (see Derive an Authority Record from a Headings in the 

Bibliographic Record) 

 Using the new Edit link from authority search results to access editing an authority record 

 Identifying the placement of new authority records in the MD Editor using File > Options 

 Validating a member’s local authority record using the new Validate in Network Zone 

option 

Step-by-Step Instructions 

The following roles can use the new options for maintaining centrally managed authority 

records in the Network Zone: 

 Cataloger 

 Catalog Manager 

 Catalog Administrator 
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To maintain centrally managed authority records using the new option to add authority 

records for headings with no match: 

(See the Derive an Authority Record from a Bibliographic Record section in these release notes 

for more information.) 

1 Edit a Network Zone bibliographic record in the MD Editor. 

2 Enter headings information in an appropriate field that you know does not exist in an 

authority record and press F3. The field displays in the normal manner with the addition of 

the new Create Authority Record button. 

3 Click Create Authority Record. The new authority record is created and displays in the MD 

Editor in the side-by-side, split screen format. 

 

Figure 35 - Quick Authority Record Created in the Network Zone 

The list of authority records also shows the new authority record that you created in the 

Network Zone. 
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Figure 36 - List of Authority Records in the MD Editor Showing Network Zone Authority Records 

Note: When you create authority records using Create Authority Record and the focus field when 

you pressed F3 is a non-preferred field such as the 600 field, the content is placed in the preferred 

field 100 in the new authority record that is created. 

4 Complete processing the bibliographic record as you normally would. 

To edit authority records from a repository search: 

1 Open the Repository Search page (Resource Management > Search and Sets > Repository 

Search). 

2 Select the Network tab. 

3 In the Find drop-down list, select Authorities, enter your search criteria, and click Go. The 

search results appear with the new Edit link. 
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Figure 37 – Network Tab Authorities Search with the Edit Link in the Search Results 

4 Click the Edit link for the authority record you want to edit. The record opens in the MD 

Editor. 

5 Edit the record as you normally would. 

To specify the placement of new authority records: 

1 Open the MD Editor (Resource Management > Cataloging > Open Metadata Editor). 

2 Select File > Options. The Options pop-up appears. 

 

Figure 38 – Placement of New Authority Records Local or Network 



 
 
 
 
 

 
 Ex Libris Confidential 58 

 
 
 
 
 

3 For the new Placement of new authority records, select Local or Network. When you save 

authority records, this setting determines how the authority record is saved, if it is saved as 

an Institution record or if it is saved as a shared Network Zone record. 

4 Click Save. 

To validate member local authority records using the Network’s validation options: 

1 Open a member local authority record in the MD Editor (Resource Management > 

Cataloging > Open Metadata Editor). 

2 Select Tools > Validate in Network Zone. 

 

Figure 39 – Validate in Network Zone 

  



 
 
 
 
 

 
 Ex Libris Confidential 59 

 
 
 
 
 

Administration 

The following enhancements were made in the Administration functional area for this release of 

Alma: 

 Passwords of internal users are now accessible only to users whose role includes the new 

USER_MANAGER_UPDATE_PASSWORD privilege. The privilege was added by default 

only to the following roles: 

 User Manager  

 User Administrator  

All other roles that have been previously able to access user records and update passwords 

will now be limited to update only records of users that are patrons only—that is, have no 

role other than Patron. 

To change this default, contact Ex Libris Support. 
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Figure 40 - User with Privilege to Update Password 

Users that have the privilege USER_MANAGER_UPDATE (which previously controlled 

the password), but not the new privilege, may now update the password only for patrons. 

If the user cannot update the password, the following fields are hidden: 

 Password 

 Verify password 

 Force password change on next login 

 Disable all login restrictions 
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Figure 41 - User Without Privilege to Update Password 

 A new privilege CONSORTIAL_SERVICES_PRIVILEGE, was added to the following 

roles:  

 Circulation Desk Manager 

 Circulation Desk Operator 

 Circulation Desk Operator-Limited 

 User Manager 
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 User Administrator 

The functionality of Find users and Find item in another institution are now based on this 

privilege. 

 To improve performance, the Query Timeout parameter was removed from the second 

page of the Add Integration Profile wizard for the Resolver Augmentation integration type. 

 Additional scheduling options were added to the Remote Storage and SIS User 

synchronization jobs. 
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Analytics 

The following sections describe new or changed Analytics features in this release of Alma. 

Added Permanent Call Number and Fulfillment Note 

Fields to Physical Items Details Dimension  

The Permanent Call Number and Fulfillment Note fields have been added to the shared 

Physical Item Details dimension of the Fulfillment subject area and the Fulfillment Note field 

has been added to Physical Item Details dimension of the Requests subject area. In addition, the 

Physical Item Details dimension has been added to the Lending Requests subject area. 

These fields allow you to create a report of lending requests that have been shipped but not 

returned. 
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Figure 42 – Fulfillment Note and Permanent Call Number 
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The following is an example of a report using the Fulfillment Note and Permanent Call Number 

fields: 

 

Figure 43 – Fulfillment Note and Permanent Call Number Report 

User Anonymization for Fines/Fees  

When fines/fees anonymization has been activated, closed fines/fees (those that are fully paid or 

waived) will be detached from the user record of the patron who owed it. Statistical patron 

information, such as User Group and User Statistics, will remain on the fine/fee record and be 

fully reportable in Analytics. 
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Figure 44 - Fines and Fees with User Information Anonymized 

Added Lifecycle Field to Portfolio Dimension  

The Lifecycle field has been added to the Portfolio dimension of the E-Inventory subject area. 

This allows you to filter reports by Active/Deleted items. To support this new field, the No. of 

Portfolio (Deleted + In Repository) field has been added and the No. of Portfolio field has 

been renamed No. of Portfolio (In Repository). 
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Figure 45 – Life Cycle, No. of Portfolio (In Repository), and No of Portfolio (Deleted + In Repository) Fields 

The following is an example of a report using the new fields: 

 

Figure 46 – Life Cycle, No. of Portfolio (In Repository), and No of Portfolio (Deleted + In Repository) Report 
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Other Analytics Enhancements 

 The Request Time field was added to the Request Date dimension of the Requests subject 

area. This field allows you to create reports such as the number of requests by hour at the 

circulation desk. 

  



 
 
 
 
 

 
 Ex Libris Confidential 69 

 
 
 
 
 

Alma Usability 

The following sections describe new or changed usability-related features in this release of 

Alma. 

Added Option to Export All Fields of Modified Table to 

Excel 

When exporting a table with hidden columns to Excel, you can now choose to export only the 

visible columns or all of the columns, including the hidden ones.  

 

Figure 47 – Export All Fields 

Inventory Number and Inventory Price Columns 

Available for List of Items 

The Inventory Number and Inventory Price fields can now be displayed in the List of Items 

page from the Columns button and can be exported to Excel from the Tools button. 
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Figure 48 –Inventory Number and Inventory Price 

Keyboard Shortcuts Added to Alma UI 

The following keyboard shortcuts have been added to the Alma UI. A tooltip with the shortcut 

appears when hovering over the button. 

 General Actions 

 Back – Alt+B  

 Next – Alt+N 

 Edit – Alt+E  

 Save – Alt+S  
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 Cancel/Close – Alt+C  

 Cancel/Close (for popups) – Esc / Alt+C  

 List Navigation 

 Next – Alt+>  

 Previous – Alt+<  

 First page – Alt+[  

 Last page – Alt+]  

 Find (focus on input box above list) – Alt+\  

Other Usability Enhancements 

 A new View option has been added under the Actions button for attachments that are in 

HTML or XML format. The attachments open in a new tab in your browser. Previously, only 

a Download option was available. 

 This release incorporates several enhancements to the MD Editor that include input from 

the Idea Exchange related to viewing inventory. See MD Editor Usability Enhancements 

above. 
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Alma APIs 

For this release, the following API enhancements were made:  

 The Retrieve PO Lines API was expanded to retrieve both locations and notes. For detailed 

information, see https://developers.exlibrisgroup.com/alma/apis/acq. 

 An API was created to retrieve a call slip for a given request or item, or list of call slips for a 

circulation desk. For detailed information, see 

https://developers.exlibrisgroup.com/alma/apis/taskslists.  

 When using an API to create a bibliographic record linked to a Network Zone record and a 

link to the Network Zone record already exists, the API now returns a redirect header with a 

URL pointing to the existing record. 

  

https://developers.exlibrisgroup.com/alma/apis/acq
https://developers.exlibrisgroup.com/alma/apis/taskslists
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Known Issues 

 When importing an EOD file using the New Order profile, if the location of the item does 

not have a call number type, the call number type of the institution should be used as the 

alternative call number type. Currently, however, no alternative call number is used.  

 Related to merging bibliographic records in the MD Editor, if there are no requests, the 

Merge Records and Combine Inventory pop-up window does not display a count of 0 (zero) 

requests. The count appears for requests only when it is greater than 0 (zero). The count 

should also appear as 0 (zero) requests when they occur. 

 Regarding the autocomplete/pop-up assistance being provided for several UNIMARC fields 

in the MD Editor, there is a known issue related to UNIMARC 327 $a and 327 $b. These 

subfields are based on the same functionality and as a result, the pop-up suggestions in the 

MD Editor suggests both subfields’ values when entering content in either the 327 $a or the 

327 $b. 

 Fixed position fields cannot be modified using the extension loader (extension packs) at this 

time. 

 When creating an OCLC Connexion import profile in a Network Zone member institution 

with the Use NZ option selected, the Use NZ record option is used upon finding a match. 

Currently, there is no possibility to select the Merge, Overlay, or Do not import options 

instead. 
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Data Services 

The Alma January Central KnowledgeBase and Community Zone package was applied to the 

Alma environments. 

Library of Congress Authorities Community Zone 

Updates   

The following are the Library of Congress Subject authority updates for the period of January 

4th through January 31st: 

 Number of records updated: 105  

 Number of records added: 199 

 Number of records deleted: 26 

The following are the Library of Congress Name authority updates for the period of January 4th 

through January 31st: 

 Number of records updated: 12448 

 Number of records added: 18697 

 Number of records deleted: 292 

New Electronic Collections Added to the Alma CKB  

The following packages were added to the Alma Community Zone from January 3rd 2016 

through January 31st 2016:  

 Bacon BMJ France Istexjournals 

 Bacon Brill France Istexjournals 

 Bacon Brill France Istexradi 

 Bacon Classiques Garnier Numérique Global Colacademie2 
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 Bacon Classiques Garnier Numérique Global Colbasile 

 Bacon Classiques Garnier Numérique Global Colbayle 

 Bacon Classiques Garnier Numérique Global Colbdl 

 Bacon Classiques Garnier Numérique Global Colbrunet 

 Bacon Classiques Garnier Numérique Global Colclf 

 Bacon Classiques Garnier Numérique Global Colclm 

 Bacon Classiques Garnier Numérique Global Colcorpusbayle 

 Bacon Classiques Garnier Numérique Global Colcorpusdictionnaires 

 Bacon Classiques Garnier Numérique Global Colcorpuslitteraire 

 Bacon Classiques Garnier Numérique Global Colcritiquelitteraire 

 Bacon Classiques Garnier Numérique Global Coldic01 

 Bacon Classiques Garnier Numérique Global Coldicbayle 

 Bacon Classiques Garnier Numérique Global Colecritsart 

 Bacon Classiques Garnier Numérique Global Colfuretiere 

 Bacon Classiques Garnier Numérique Global Colgodefroy 

 Bacon Classiques Garnier Numérique Global Colgrammaires 

 Bacon Classiques Garnier Numérique Global Colgrammaires16 

 Bacon Classiques Garnier Numérique Global Colgrammaires17 

 Bacon Classiques Garnier Numérique Global Colhuguet 

 Bacon Classiques Garnier Numérique Global Collacurne 

 Bacon Classiques Garnier Numérique Global Collarousse 

 Bacon Classiques Garnier Numérique Global Collittre 

 Bacon Classiques Garnier Numérique Global Colmontaigne 

 Bacon Classiques Garnier Numérique Global Coloceanindien 

 Bacon Classiques Garnier Numérique Global Colpatrologie 
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 Bacon Classiques Garnier Numérique Global Colremarques 

 Bacon Classiques Garnier Numérique Global Colrevolempire 

 Bacon Classiques Garnier Numérique Global Colrichelet 

 Bacon Classiques Garnier Numérique Global Colyverdon 

 Bacon Classiques Garnier Numérique Global Garnier 

 Bacon De Gruyter France Istexjournals 

 Bacon Institute Of Physics Publishing France Istexjournals 

 Bacon NPG France Istexjournals 

 Bacon Oxford University Press France Istexjournals 

 Bacon Royal Society of Chemistry France Istexjournals 

 Bacon Sage Publications France Istexjournals 

 Bacon Springer France Istexjournals 

 Bacon Wiley France Istexjournals 

 CRCnetBASE Complete 

 ebrary Academic Complete Subscription UKI Edition 

 ebrary Education Subscription 

 ebrary Law Subscription 

 ebrary Literature & Language Subscription 

 ebrary Science & Technology Subscription 

 ebrary: The Arts Subscription 

 IEEE Xplore All Power & Energy Standards 

 IEEE Xplore MIT Press Journals Library 

 IEEE Xplore National Electrical Safety Code (NESC) 

 IEEE Xplore POP 1998 

 IEEE Xplore POP 2005 
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 IEEE Xplore Smart Grid Research 

 IEEE Xplore SMPTE Standards 

 IEEE Xplore Standards Foundations for Smart Grid 

 IEEE Xplore Standards Select 

 JUSTICE American Chemical Society All Publication 2016 

 JUSTICE Karger Online Journal Collection 2016 

 Lyrasis SpringerLink Journals Tons 

 Lyrasis SpringerLink Journals Upgrade 

 man_Elsevier_lbw 

 man_EZB: American Chemical Society 

 man_EZB: American Institute of Physics (AIP) (Archive) 

 man_EZB: American Physical Society Digital Backfile Archive 

 man_EZB: Annual Reviews (Archive) 

 man_EZB: Berkeley Electronic Press Academic Journals 

 man_EZB: Blackwell Publishing Journal Backfiles 

 man_EZB: Brill Journal Archive Online 

 man_EZB: British Periodicals Collection 

 man_EZB: China Academic Journals CAJ 

 man_EZB: Columbia International Affairs Online (CIAO) 

 man_EZB: Economist Historical Archive 1843 - 2006 

 man_EZB: Financial Times Historical Archive 1888-2006 

 man_EZB: Informa Healthcare 

 man_EZB: Institute of Physics (IOP) (Archive) 

 man_EZB: IUCR 

 man_EZB: Konsortium Baden Württemberg Wiley 
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 man_EZB: Konsortium Baden-Württemberg Springer 

 man_EZB: Lippincott Williams & Wilkins 

 man_EZB: Making of the Modern World 

 man_EZB: MUSE Standard 

 man_EZB: Nature Archive 

 man_EZB: Oxford University Press (Full, STM, HSS) 

 man_EZB: Taylor & Francis 

 man_EZB: The Nation Digital Archive 

 man_EZB: The New Republic 

 man_EZB: Times 

 man_EZB: Walter de Gruyter Online-Zeitschriften Archiv 

 man_EZB: Walter de Gruyter Online-Zeitschriften Linguistics, Literature and Humanities – 

LLH 

 Ovid Lippincott Williams and Wilkins Total Access Collection 2016 

 Oxford Handbooks Online Archaeology 

 Palgrave Connect eBooks Political Science Collection 2015 

 ProQuest Accounting, Tax & Banking Collection 

 ProQuest Advanced Technologies & Aerospace Database 

 ProQuest Agricultural & Environmental Science Database 

 ProQuest Asian & European Business Collection 

 ProQuest Biological Science Database 

 ProQuest British Periodicals Collection 3 New Platform 

 ProQuest Business Market Research Collection 

 ProQuest Business Premium Collection 

 ProQuest Central (new) 
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 ProQuest Continental Europe Database 

 ProQuest Country Life Archive 

 ProQuest Criminal Justice Database 

 ProQuest Criminology Collection 

 ProQuest Earth, Atmospheric & Aquatic Science Database 

 ProQuest East & South Asia Database 

 ProQuest East Europe, Central Europe Database 

 ProQuest Education Collection 

 ProQuest Entertainment Industry Magazine Archive: Cinema, Film and Television 

 ProQuest Entertainment Industry Magazine Archive: Music, Radio and The Stage 

 ProQuest Ethnic NewsWatch 

 ProQuest FIAF International Index to Film Periodicals Database 

 ProQuest Health & Medical Collection 

 ProQuest Health Research Premium Collection 

 ProQuest India Database 

 ProQuest Latin America & Iberian Database 

 ProQuest Library & Information Science Collection 

 ProQuest Linguistics Collection 

 ProQuest Linguistics Database 

 ProQuest Materials Science & Engineering Database 

 ProQuest Medical Database 

 ProQuest Middle East & Africa Database 

 ProQuest Music & Performing Arts Collection 

 ProQuest Natural Science Collection 

 ProQuest Nursing & Allied Health Database 
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 ProQuest Philosophy Collection 

 ProQuest Philosophy Database 

 ProQuest Politics Collection (New) 

 ProQuest Psychology Database 

 ProQuest SciTech Premium Collection 

 ProQuest Screen Studies Collection 

 ProQuest Social Science Premium Collection 

 ProQuest Sociology Collection 

 ProQuest Technology Collection (New) 

 ProQuest Trench Journals and Unit Magazines of the First World War 

 ProQuest Turkey Database 

 ProQuest UK and Ireland Database 

 Scientific Research Publishing (SCIRP) 

 SpringerLink Books Business And Management 2016 

 SpringerLink Books Computer Science And Engineering German 2016 

 SpringerLink Books Computer Science Without Lecture Notes 2016 

 SpringerLink Books Education 2016 

 SpringerLink Books Lecture Notes In Computer Science 2016 

 SpringerLink Books Professional And Applied Computing 2016 

 TAEBDC Abc-Clio eBooks 2014 

 TAEBDC DeGruyter eBooks 2014 

 TAEBDC Jstor Books 2014 

 TAEBDC Sage eBooks 2014 

 TAEBDC TAO eBooks 2014 

 TAEBDC Taylor & Francis eBooks 2014 
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 University of California Press Journals 

 University of Chicago Press Journals 

 University of Chicago Press Journals (Current Content) 

 VETnetBASE 

 Wiley Online Library 2016 Full Collection 

 Wiley Online Library Free 2016 

 Wiley Online Library Open Access 2016 

 Wiley Online Library: Medicine and Nursing 2016 

 Wiley Online Library: SSH 2016 

 Wiley Online Library: STM 2016 

Note: No new external resources were added for this release. 
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